Thank You for Choosing Ross

You’ve made a great choice. We expect you will be very happy with your purchase of Ross Technology. Our mission is to:

1. Provide a Superior Customer Experience
   - offer the best product quality and support
2. Make Cool Practical Technology
   - develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
Ulritouch · User Guide

- Ross Part Number: **2201DR-304-02**
- Release Date: October 30, 2019.

The information contained in this Guide is subject to change without notice or obligation.

**Copyright**

©2019 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

**Patents**


**Notice**

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

**Safety Notices**

Refer to the “Important Regulatory and Safety Notices” document that accompanied your product.

**Statement of Compliance**

This product has been determined to be compliant with the applicable standards, regulations, and directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is available upon request by contacting techsupport@rossvideo.com. Please include the product; model number identifiers and serial number and country that compliance information is needed in request.

**EMC Notices**

**United States of America - FCC Part 15**

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Canada**

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

---

**Notice** — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user’s authority to operate this equipment.
European Union
This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause radio interference.

Australia/New Zealand
This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea
This equipment is in compliance with the provisions established under the Radio Waves Act.
Class A equipment (Broadcasting and communications service for business use).
This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be aware of this fact. This device is intended for use in areas outside home.

<table>
<thead>
<tr>
<th>Type of Equipment</th>
<th>User’s Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>A급 기기 (업무용 방송통신기자재)</td>
<td>이 기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.</td>
</tr>
<tr>
<td>Class A Equipment (Industrial Broadcasting &amp; Communication Equipment)</td>
<td>This equipment is <strong>Industrial (Class A) electromagnetic wave suitability equipment</strong> and seller or user should take notice of it, and this equipment is to be used in the places except for home.</td>
</tr>
</tbody>
</table>

International
This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for a Class A Digital device.

Notice — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Warranty and Repair Policy
The product is backed by a comprehensive one-year warranty on all components.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross. Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty
For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information, contact your regional sales manager.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You can also contact Ross Video for more information on the environmental performances of our products. This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your area. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
Contents

Introduction ........................................... 9
  Related Publications ........................................... 9
  Documentation Conventions ................................... 9
  Interface Elements .......................................... 9
  User Entered Text ............................................. 9
  Referenced Guides ............................................ 10
  Menu Sequences .............................................. 10
  Important Instructions ....................................... 10
  Contacting Technical Support ................................ 10

Getting Started ........................................ 11
  Overview .................................................... 11
  Features ..................................................... 11
  System Overview ........................................... 12
  Before You Begin ........................................... 12
  Installation and Setup Overview .......................... 12
  Ultritouch Operation Overview ............................ 13
  Using Custom Panels on Ultritouch ....................... 13

Hardware Overview ..................................... 15
  Front Panel Overview ...................................... 15
  Rear Panel Overview ....................................... 16

Physical Installation ..................................... 19
  Before You Begin .......................................... 19
  Mounting Requirements ..................................... 19
  Connecting the Ultritouch to a Network .................. 19
  Connecting to a Power Supply ............................. 20

Configuring the Network Settings ...................... 23
  Overview .................................................... 23
  Using Walkabout to Assign the Ultritouch IP Address .... 23
  Adding the Ultritouch Router to the Tree View in DashBoard ................................................................. 23
  Updating the Network Settings for the Ultritouch via the Hard Panel ......................................................... 24
  Re-naming the Ultritouch .................................... 25

Basic Navigation ........................................ 27
  Using the Touchscreen ...................................... 27
  Navigating the Ultritouch Menus via the Touchscreen ................................................................. 27
  Using a DashBoard Client Computer ...................... 28
  Navigating the Ultritouch Menus via a DashBoard Client Computer ......................................................... 29

Communications with Devices .......................... 31
  Before You Begin .......................................... 31
  Automating Connections ................................... 31
  Using the Auto Detect Feature ............................. 31
  Using the Auto Connect Feature ......................... 31
  Manually Connecting to an External Device ............... 32
  OGP and JSON Connections .............................. 32
Introduction

This guide covers the installation, configuration, and use of the Ultritouch-2 and Ultritouch-4. The following chapters are included:

- **“Introduction”** summarizes the guide and provides important terms, and conventions.
- **“Getting Started”** provides an overview for creating a routing system with Ultritouch, and general information to keep in mind before installing and configuring your Ultritouch panel.
- **“Hardware Overview”** provides a basic introduction to the Ultritouch front and rear panels.
- **“Physical Installation”** provides instructions for the basic physical installation of the Ultritouch panel.
- **“Configuring the Network Settings”** provides instructions for configuring the network settings for the Ultritouch and navigating the touch-screen menus.
- **“Basic Navigation”** outlines the methods for accessing the Ultritouch menu system.
- **“Installing License Keys”** provides instructions on installing license keys on the Ultritouch.
- **“Communications with Devices”** outlines how to enable the Ultritouch to communicate with devices in your routing system.
- **“File Management”** outlines how to load a custom panel to Ultritouch and how to access the File Navigator interface, and manage your device files from the Ultritouch panel.
- **“Managing Open Windows”** outlines how to use this feature to quickly navigate, manage, and operate the devices connected to your Ultritouch.
- **“Menu System Overview”** summarizes the functions, menus, and parameters of the Ultritouch tabs and windows in DashBoard.
- **“Technical Specifications”** provides the specifications for the Ultritouch.
- **“Glossary”** provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your Ultritouch:

- **DashBoard User Manual**, Ross Part Number: 8351DR-004
- **Ultritouch Quick Start Guide**, Ross Part Number: 2201DR-902
- **Ultritouch + Ultrix User Guide**, Ross Part Number: 2201DR-904
- **Walkabout Application Note**, Ross Part Number: 2201DR-003

★ Our user documentation is available for download from our website.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

**Interface Elements**

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the **Edit** dialog, click **Insert Above**.

**User Entered Text**

Courier text is used to identify text that a user must enter. For example:
In the **Language** box, enter **English**.

**Referenced Guides**

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the *Ultrix User Guide*.

**Menu Sequences**

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a step reads “**File > Save As**,” you would click the **File** menu and then click **Save As**.

**Important Instructions**

Star icons are used to identify important instructions or features. For example:

⭐ Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

**Contacting Technical Support**

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support**: (+1) 613-652-4886
- **After Hours Emergency**: (+1) 613-349-0006
- **E-mail**: techsupport@rossvideo.com
- **Website**: http://www.rossvideo.com
Getting Started

If you have questions pertaining to the operation of Ultritouch, please contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

* This guides uses the term Ultritouch to reference both the Ultritouch-2 and Ultritouch-4 unless otherwise noted.

Overview

Ultritouch is a forward thinking, powerful system control panel from Ross Video. The panel is a rack-mountable touchscreen that combines traditional functionality while adapting work flows in a simple and intuitive interface. Due to its integration of DashBoard, Ultritouch controls a host of other Ross equipment in addition to third-party signal processing products.

Ultritouch supports a full version of DashBoard, which allows users to control and monitor things like openGear cards, create custom panels, etc. Not only do these new enhanced panel work flows encompass the broad range of hard panel operations, but they also provide a fully integrated touch UI that enables a user to quickly setup and use their panel.

The touchscreen also means that users can use the common DashBoard framework to build a completely custom set of panels with different button combination sizes, functions, and layouts, enhancing what is possible from a normal hardware button-based panel. Ultritouch combines common DashBoard touch controls, enhanced work flow specific product controls, and the ability to make completely user-definable panels for any application.

Features

The Ultritouch is used when you require advanced control functions from a single point. DashBoard client software runs on the Ultritouch panel to provide flexible connectivity.

The following features are included:

- Touch-enabled DashBoard based remote control panel (RCP)
- Redundant power supply option
- Integrated speakers for monitoring
- HDMI and USB for external KVM operation
- DashBoard client software built on Ethernet and TCP/IP technology to allow remote access across LAN architectures
- Standard UI layout for openGear cards
- DashBoard tree and system management support
- Ability to store multiple panel types with intuitive navigation based on desired work flow
- Load customized user interfaces to control a wide range of Ross Video products and third-party systems
- Full control of DashBoard Connect devices with real-time control and alarming from a single Ultritouch panel
- Ability to have multiple control views active and available for selection on one touchscreen
- Easily upgrade the software and firmware on the Ultritouch panel in the field
System Overview
The Ultritouch is used when you require advanced control functions from a single point.

Before You Begin
Before configuring and operating the Ultritouch, contact your IT department before connecting to your facility network to ensure that there are no conflicts.

Installation and Setup Overview
The generalized work flow of installing and configuring your Ultritouch is:
1. Implement your routing system plan by installing the devices, configuring their settings, and setting up your databases and matrices.
2. Install and configure the Ultritouch.
3. Establish communications between Ultritouch and the devices in your routing system.
4. Install required license keys for additional device control.

For More Information on...
- planning and installing your routing system, refer to the user documentation that accompanied your devices.
Ultritouch Operation Overview

Once configured, the Ultritouch provides central controller functionality for the routing system, including:

- the storage and implementation of routing system configurations, which collect a series of routing matrices into a system and provide a logical database view of the whole system
- switching the physical crosspoints of the routers according to the system configuration
- the control and system database interface for devices that control and/or display routing status (e.g. remote control panels, switchers, master control, automation systems, multi-viewers, and tally systems)
- virtual routing, matrix partitioning, and mapping
- label support for protocols supporting labels
- system control through DashBoard client software running on the Ultritouch panel
- connection and status logging

Using Custom Panels on Ultritouch

Once your router connections are defined, and a database is established, you can start building a map of several different physical devices that become one virtual device. When a switch request is made for a virtual device, all the physical devices that are mapped to the virtual device are switched.

Ultritouch enables you to map inputs and outputs from routers for control via any remote control panel. These parameters can be saved to a database, enabling you to change configurations easily and quickly, allowing devices to used in a number of different operating scenarios.
Hardware Overview

This chapter presents information on the front and rear panels of the Ultritouch-2 and Ultritouch-4.

Front Panel Overview

Each Ultritouch front panel is a touchscreen display that enables you to access the features, settings, and monitoring options of the product. (Figure 3.1, Figure 3.2)

1. **DB Button**

Tap this button to display the Ultritouch Device interface, which is the main/Home menu. From this interface you access the following configuration features:

- General Info
- Manage Open Views
- Manage Custom Panels
- Connected Devices
- Network Settings
- License Management
2. Connected Devices Button

Tap this button to display the All Connections interface in the Main Window. This interface reports the external devices that are communicating with the Ultritouch. Each device is represented as an individual button that when tapped displays the DashBoard menu system in the Main Window. Devices are added to the All Connections interface via the Ultritouch Device > Connected Devices interface.

3. File Navigator Button

Tap this button to display the File Navigator interface in the Main Window. Use this interface to select any custom panels uploaded into Ultritouch.

4. Open Windows Button

Tap this button to reveal thumbnails of the currently open windows. Tapping a thumbnail opens that window full screen. This is useful for swapping between control panels for different devices.

5. Lock Button

Tap this button to lock the Ultritouch panel and display a spinner icon. You must tap and spin the icon to unlock the interface.

6. Home Window

The items in this window change depending on the function selected. This window can also display the currently loaded Ultrix soft panel or a custom panel for a DashBoard Connect compatible device.

7. Headphone Jack (Ultritouch-4RU only)

This is a 3.5mm headphone jack. When in use, the internal speaker of the Ultritouch panel is muted.

8. USB Port (Ultritouch-4RU only)

This is a standard USB 3.0 port. This port is not implemented.

Rear Panel Overview

The Ultritouch rear panel provides connections for power supplies, communications, and network connections.

For More Information on...
- the power specifications, refer to the section Table 11.4.

![Figure 3.3 Ultritouch-2 — Rear Panel, Side View](image)
1. **PWR1 and PWR2 Connections**

There are two power supply connectors located on the rear of each Ultritouch. Each connector requires a 15VDC connection to an external power supply.

![Notice](https://via.placeholder.com/150)

**Notice** — The Ultritouch automatically powers on when power is applied.

Each Ultritouch ships with one power supply. An option is available to order a second power supply for redundancy.

2. **HDMI Port**

This port is not implemented.

3. **USB Port**

This port is not implemented.

4. **ENET1 and ENET2 Ports**

Each ENET port is an RJ45 connector used to connect the Ultritouch to an external Ethernet network.

![Notice](https://via.placeholder.com/150)

**Notice** — The Ethernet ports do not provide, nor make use of, Power-over-Ethernet (PoE).

Use the **ENET 1** port to bridge the external Ethernet network to the local communications bus for monitoring and control of the Ultritouch.

* The **ENET 2** port is not implemented.
Physical Installation

If you have questions pertaining to the installation of Ultritouch, please contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

Before You Begin

These installation guidelines assume the following:

- The relevant Ross equipment is installed into a ventilated rack frame. The relative humidity in the environment of the equipment should be <70% (non-condensing). The ambient temperature of the air entering the front panel should not exceed 40°C (104°F), and should not fall below 0°C (32°F).
- The install location of the router should be accessible, dry, and dust-free.
- The socket/outlet should be installed near the equipment and be easily accessible.
- Valid IP addresses are assigned to the equipment.

Static Discharge

Throughout this chapter, please heed the following cautionary note:

<table>
<thead>
<tr>
<th>ESD Susceptibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit boards and related equipment.</td>
</tr>
</tbody>
</table>

Mounting Requirements

The Ultritouch panel is designed for installation into a standard 19” equipment rack. It has integrated rack ears, allowing it to be screwed in using standard screws and cage nuts.

The Ultritouch panel mounts in the rack frame by means of four rack screws fastened through the front mounting ears. This should normally be sufficient to carry the load, including the weight of accompanying cables.

Under some conditions, the ambient air temperature inside rack-mount cabinets can be greater than the ambient temperatures within a room. For safe long term reliability, ensure the ambient air temperatures at the router front intake are within the router’s specified operating temperature range. Adequate ventilation within a rack frame must also be maintained.

For More Information on...

- the technical specifications for the Ultritouch, refer to the chapter “Technical Specifications” on page 45.
- installing the Ultritouch, refer to the Ultritouch Quick Start Guide.

Connecting the Ultritouch to a Network

The ENET 1 port is a standard 10/100/1000 RJ45 Ethernet connector and is used to exchange data and communicate with other devices in your router system.

- Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

The Ultritouch is connected directly to your network so that it can interface with the devices in your routing system. After a physical connection is established, use the DashBoard client running on your Ultritouch to configure the network settings for the Ultritouch.
To establish a physical connection to the network

1. Connect one free end of the straight through CAT5/5e/6 cable to a free port of the network hub.
2. Connect the other end of the same cable to ENET 1 on the Ultritouch rear panel.

Connecting to a Power Supply

The Ultritouch panel is powered by one +15V DC, 30W PSU, with an optional PSU available to provide redundancy and load sharing.

For redundancy, each power cord should be connected to a separate power source for protection against failure of the A/C power circuit. In the event of one power supply failure, the panel load is seamlessly transferred to the other connected redundant power supply.

Warning Hazardous Voltages — The safe operation of this product requires that a protective earth connection be provided. This protective earth is provided by the ground conductor in the equipment's supply cord. To reduce the risk of electrical shock to operator and service personnel, this ground connector must be connected to an earthed ground.
To connect the power cables to the Ultritouch panel

**Warning** — In some countries it may be necessary to supply the correct mains supply cord. Use only certified cords for the country of use.

**Notice** — The Ultritouch automatically powers on when power is applied.

1. Connect the male end of the provided power cable into the socket marked PWR1 on the Ultritouch rear panel.

![Figure 4.3 Ultritouch-2 — Primary Power Connection](image)

**Note:** It is recommended that you always connect the Power Supply Unit to the Ultritouch-2 before connecting to Mains Power.

2. Connect the remaining power cable into the PWR2 power supply socket if redundancy is required.

3. Connect the supplied AC power cable into the power modules.

4. Connect the supplied power cable’s three-prong male connector to an AC outlet.
Configuring the Network Settings

The Ultritouch system comes pre-configured with default settings that you may wish to configure as per your facility requirements. This chapter outlines how to assign a static IP Address to the Ultritouch panel, and navigate the menu system of the touch-screen panel.

Overview

Updating the network settings is the first task to accomplish once the physical installation is completed. There are two methods outlined in this chapter:

- **Walkabout** — use the Walkabout application, running on a DashBoard client computer in your network.
- **Ultritouch** — use the touchscreen of the Ultritouch hard panel.

Using Walkabout to Assign the Ultritouch IP Address

Once the Ultritouch panel is physically installed and cabled to your facility network, you will need to assign it a static IP Address to enable DashBoard (running on a computer connected to the same subnet) to locate it on your network. Establishing a static IP Address enables the DashBoard client running on Ultritouch to detect other DashBoard Connect compatible devices on the same subnet.

**To assign a static IP address to the Ultritouch panel**

1. Launch a DashBoard client from a computer connected to the same IP address subnet as the Ultritouch.
2. From the DashBoard client main toolbar, select **File > Show Walkabout**.
   - The DashBoard window displays the **Walkabout** table.
3. Click **Refresh**, located at the bottom of the **Walkabout** tab, to ensure the list in the **Walkabout** table is current.
4. In the **Walkabout** table, find the entry for the Ultritouch you want to configure.
   - It may be identified in the table via the default IP Address of 192.168.20.160.
5. Use the **Name** field to assign a unique identifier to the Ultritouch panel. This will be the name displayed in the Tree View of DashBoard.
   - After you edit a cell in the **Walkabout** table, the **Connection/Link Quality** value for the device reports 1%. It is recommended to wait approximately 1 minute, then click **Refresh** to apply the new settings.
6. Use the **Address** field to specify the IP Address supplied by your IT Department for this device.
7. Ensure the **Netmask** field is set to match your network requirements.
8. Use the **Gateway** field to specify the IP Address for connection outside of the local area network (LAN).
9. Click **Reboot** in the row of the **Walkabout** table for the Ultritouch.

Adding the Ultritouch Router to the Tree View in DashBoard

Once you have assigned the Ultritouch a static IP Address, you can then manually add it to the Tree View. Manually Adding the Ultritouch displays its node in the Tree View in the DashBoard client software on your computer, granting you access to the interfaces described in the chapter “Menu System Overview” on page 39.

**To manually add the Ultritouch to the Tree View in DashBoard**

1. In the **Basic Tree View** toolbar of DashBoard, click ![Select Equipment or Service Type to Add](image).
2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

   The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.

6. Enter the IP Address for the panel in the IP Address field that you assigned in the section “To assign a static IP address to the Ultritouch panel” on page 23.

7. In the text fields provided, enter the display name and the port of the panel you wish to add.

8. Click Finish.

   The Ultritouch displays in the Tree View.

### Updating the Network Settings for the Ultritouch via the Hard Panel

You may wish to change the Ultritouch network settings from the default values but do not have access to a computer running the Walkabout application. The touch-screen menu system enables you to change the IP Address and update other network settings.

There are two methods to assign an IP address to the Ultritouch: manually assigning the settings or enabling the DHCP server in your network to assign the settings to the panel. Both methods are described below.
To manually assign the network settings to the Ultritouch

1. Tap 📱.
   ✪ You will need to scroll through the menu list displayed under the Ross logo.

2. Tap **Network Settings**.

3. In the DHCP area, tap **Off**.
4. Use the **IP** field to assign a static IP Address to the Ultritouch.
5. Use the **Subnet** field to specify the subnet mask for your network.
6. Use the **Gateway** field to specify the gateway for communications outside of the local area network (LAN) that the Ultritouch will use.
7. Tap **Apply**.

To automatically obtain the network settings for the Ultritouch

1. Tap 📱.
   ✪ You will need to scroll through the menu list displayed under the Ross logo.

2. Tap **Network Settings**.
3. In the DHCP area, tap **On**.
4. Tap **Apply**.

Re-naming the Ultritouch

Each Ultritouch can be given a unique name that is used on internal menus and as the identifier in the routing system.

To re-name the Ultritouch

1. Tap 📱.
2. Tap **General Info**.
3. Select the **Device Name** field.
4. Type a new name for the Ultritouch in the **Device Name** field.
5. Tap **Apply**.
Basic Navigation

There are two methods for accessing the Ultritouch menu system: via a DashBoard client running on a computer connected to the same subnet as the Ultritouch, or via the touchscreen of the hard panel. This chapter outlines both methods.

★ This chapter uses the Ultritouch-2 in its examples, but the information also applies to the Ultritouch-4.

For More Information on...
- the menus and options in each interface, refer to the chapter “Menu System Overview” on page 39.

Using the Touchscreen

The Ultritouch touchscreen menu system is organized into four interfaces: Ultritouch Device, All Connections, File Navigator, and Open Windows. Each interface is represented as a button on the left toolbar of the panel. Tap a button to display that interface on the touchscreen. Figure 6.1 illustrates the user selecting the Network Settings button on the Ultritouch Device interface.

![Figure 6.1 Example of Navigating the Ultritouch Touchscreen](image)

Use this method of navigating the menu system to access:
- multiple device views
- custom panels
- Ultrix soft panels

Navigating the Ultritouch Menus via the Touchscreen

The interfaces are accessed by tapping buttons on the main toolbar of the Ultritouch panel.

To access the Ultritouch Device interface via the touchscreen

1. Tap .

2. To access additional menus:
   a. Scroll through the menus using the arrows.
   b. Tap a button to displays its interface.
Note that the button you tap now displays a blue bar on its right side.

To access the All Connections interface

• Tap 🌐.

To access the File Navigator interface

• Tap 📂.

To access the Open Windows interface

• Tap 🗂.

A maximum of 4 windows can be opened at one time. When the limit is reached, the panel with the earliest timestamp is automatically closed.

Using a DashBoard Client Computer

The Ultritouch displays as a device node in the Basic Tree View in the window of your DashBoard client. Much like other DashBoard Connect devices, you access the interfaces and menus of Ultritouch by first selecting its node in the Basic Tree View to display the device view of the panel in the DashBoard window.

When using a DashBoard client computer to access the Ultritouch, the interfaces are organized into a series of buttons at the bottom of the window. By default, the General Info interface displays as the homepage.

Use this method of navigating the menu system to:

• load device views
• load custom panels

Figure 6.2 illustrates an Ultritouch displayed in the DashBoard client window after the user selected the Network Settings button.
Navigating the Ultritouch Menus via a DashBoard Client Computer

Star The DashBoard client computer must be connected to the same subnet as your Ultritouch panel.

To access the Ultritouch Device interface via a DashBoard client computer

1. Launch DashBoard by double-clicking its icon on your computer desktop.
2. Ensure the DashBoard client computer is running DashBoard software version 8.5.0 or higher.
   This information is available by selecting Help > About DashBoard from the main toolbar.
3. Locate the Ultritouch in the Tree View of DashBoard.
4. Expand the Ultritouch node to display the Ultritouch Device sub-node.
5. Double-click the Ultritouch Device sub-node.

   The Ultritouch Device interface displays in the right-side of the DashBoard window with a bottom toolbar that includes selectable buttons.
Communications with Devices

This chapter provides a general procedure for creating a connection point between the Ultritouch and external devices in your routing system. The specific steps for your devices may differ than what is presented here.

* The procedures in this chapter assume you are navigating the Ultritouch menus via the hard panel.

For More Information on...
- the menu system, refer to the chapter “Menu System Overview” on page 39.
- creating a connection point between the Ultritouch and your device, refer to the user documentation for your device.

Before You Begin

The Connected Devices interface lists external devices that the Ultritouch detects and can connect to, and provides status information. You can also disconnect communications between a device from Ultritouch. There are two methods for adding an external device to the Ultritouch: using the auto connect feature or manually adding a device by specifying the IP address of the device. Both methods are described in this chapter.

* You can also drag and drop devices nodes from the Basic Tree View to the Ultritouch Connected Devices tab in a DashBoard client. Refer to the Ultritouch Quick Start Guide for details.

* This chapter uses the Ultritouch-2 in its examples, but the information also applies to the Ultritouch-4.

Automating Connections

There are two features that you can use to auto detect and connect to external devices in your routing system.

Using the Auto Detect Feature

By default the Ultritouch auto detects any external device on the same IP subnet. Ultritouch queries the network for new devices approximately every 10 seconds if the Automatic Detection feature is enabled.

To enable the Ultritouch to auto detect external devices in your routing system

1. Tap .
2. Tap Connected Devices.
3. Tap Enable Auto Detect.

Using the Auto Connect Feature

The auto connect feature is independent from the auto detect feature. This allows you to still manually select what devices to connect to. Once the auto connect feature is enabled, Ultritouch will automatically create a connection point to devices listed in the Connected Devices table.
To enable the Ultritouch to auto connect to external devices in your routing system

1. Tap .
2. Tap Connected Devices.
3. Tap Enable Auto Connect.

Manually Connecting to an External Device

You must manually create a connection point to an external device when the device is on a different subnet from your Ultritouch.

If the Auto Detect or Auto Connect options are disabled, you can still create a connection point to an external device by manually specifying their IP address in the Ultritouch Device interface.

To manually add a connection point to an external device

1. Tap .
2. Tap Connected Devices.
3. Tap Add.
4. Tap Manually Add a Connection Point.
5. Use the Device IP/Hostname field to specify the IP Address for the external device.
6. Tap Add Device.
   The device is now listed in the Connected Devices table.
7. Select the device from the Connected Devices table.
8. Tap Connect.

OGP and JSON Connections

This section outlines how to establish a connection point when your device communicates over TCP via the openGear protocol (OGP) or the JavaScript Object Notation (JSON).

To manually add a connection point to an external device via OGP or JSON protocol

1. Tap .
2. Tap Connected Devices.
3. Tap Add.
4. Tap TCP/IP DashBoard Connect/openGear Device.
5. Use the Device IP/Hostname field to specify the IP Address for the external device.
6. Use the Device Name field to specify the device name (as you want it to appear in the Ultritouch interfaces).
7. Use the Protocol menu to specify whether the device communication language.
8. Use the Port field to specify the port on the device used for communicating with the Ultritouch.
9. Select the Remember connection settings for this device to retain the settings after a loss of communication.
10. Tap **Add Device**.
11. Select the device from the **Connected Devices** table.
12. Tap **Connect**.
File Management

This chapter outlines how to use the File Navigator interface to load your custom panel and device files to the Ultritouch.

★ This chapter uses the Ultritouch-2 in its examples, but the information also applies to the Ultritouch-4.

★ A connection must be established between Ultritouch and the device that you are uploading the file to. Refer to the chapter “Communications with Devices” on page 31 for details.

Loading Custom Panels

The File Navigator interface enables you to quickly navigate to device custom panels. A custom panel is a user interface created using the PanelBuilder™ tool in DashBoard. Custom panels can include any combination of PanelBuilder objects, panel components, and parameters. Custom panels enable you to create interfaces for your DashBoard Connect devices, then load the panel file to the Ultritouch for operating and monitoring that device.

For More Information on...
• using PanelBuilder, refer to the DashBoard User Guide.

Before You Begin

PanelBuilder provides a template for creating and editing a custom panel for use on an Ultritouch hard panel. This template is a canvas layout of 1304x203 pixels to match the hard panel display area. You must create a custom panel using PanelBuilder on your DashBoard client computer before you can upload and use it on Ultritouch.

For More Information on...
• creating and editing custom panels for Ultritouch, refer to the DashBoard User Guide.
• creating a soft panel for Ultrix, refer to the Ultritouch+Ultrix User Guide.

Uploading a Custom Panel File to the Ultritouch Directory

Once you have created your Ultritouch custom panel in PanelBuilder, you can open and load the file to an Ultritouch hard panel. You can upload multiple custom panels to the Ultritouch system, but the hard panel can only display one custom panel at a time.

★ Before proceeding, ensure you have established communications between the Ultritouch and the device the custom panel was designed for.

To upload a custom panel file to the Ultritouch

1. Navigate to the Ultritouch Device interface using the method described in “To access the Ultritouch Device interface via a DashBoard client computer” on page 29.
2. Click Manage Custom Panels.

The Custom Panels interface displays in the DashBoard window.
3. Click **Upload to Folder**.
   The Upload File dialog opens.
4. Select the custom panel file to load.

* Uploaded *.zip files (custom panels with image assets etc.) are automatically unzipped into a directory named the same as the original *.zip file.

**Using Custom Panels**

To operate a custom Panel, use the File Navigator to browse the Custom Panels directory. The File Navigator interface displays and uploaded custom panels in a hierarchy. This hierarchy is determined by the timestamp of the loaded files.

**To open a custom panel**

1. On the Ultritouch hard panel, tap ➕.
2. Navigate to the file you wish to open.
3. Tap **Open File**.

**To remove a device file from the File Navigator interface**

1. On the Ultritouch hard panel, tap ➕.
2. Navigate to the file you wish to remove.
3. Tap the file to reveal the available operations.
4. Tap **Remove**.
Managing Open Windows

Ultritouch tracks the DashBoard Connect devices that you frequently access and arranges their “view” in a single window for ease of use.

★ This chapter uses the Ultritouch-2 in its examples, but the information also applies to the Ultritouch-4.

To specify a new device view

1. Tap ⌁.
2. Tap Manage Open Views.

3. Perform one of the following:
   • ![Devices Navigation](image)
     — Tap this button to display the Devices Navigation interface.
   • ![Files Navigation](image)
     — Tap this button to display the Files Navigation interface.

   The interface updates to show a list of external devices made available using the procedures in “Communications with Devices” on page 31.

4. Tap the device you wish to view.
5. Tap Open Selected.

To specify a new file view

1. Tap ⌁.
2. Tap Manage Open Views.
3. Tap Files.

   The interface updates to show a list of devices files made available using the procedures in “Using File Navigator” on page 31.

4. Tap the entry for the file you wish to view.
5. Tap Open Selected.

To view a new device interface on the Ultritouch

1. Tap ⌁.
2. Tap the entry for the device you wish to access.
To close a device interface from the Ultritouch

1. Tap 📱.
2. Tap the X next to the device name you wish to close.
Menu System Overview

There are two methods for accessing the interfaces: a DashBoard client computer or using the Ultritouch hard panel. This chapter outlines the menus available using both methods but uses the menus from the hard panel in the provided examples.

★ This chapter uses the Ultritouch-2 in most of the examples, but the information also applies to the Ultritouch-4 unless otherwise noted.

Ultritouch Device Interface

Use this interface to change the network settings for the panel, establish communications with devices in your routing system, manage your custom panels, and download system logs for troubleshooting.

General Info

By default, the General Info window is automatically displayed when the Ultritouch Device interface is loaded.

★ To access this interface on a DashBoard client computer, double-click the Ultritouch Device sub-node in the Tree View.

![Figure 10.1 Example of the General Info Window on an Ultritouch-2 Panel](image)

Table 10.1 summarizes the read-only fields displayed in the General Info window.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>&lt;text&gt;</td>
<td>Identifier assigned to this panel during the installation and setup</td>
</tr>
<tr>
<td>Device ID</td>
<td>#</td>
<td>An unique number assigned to the hard panel to help identify it within your system</td>
</tr>
<tr>
<td>Type</td>
<td>&lt;text&gt;</td>
<td>Defines the model of Ultritouch panel</td>
</tr>
<tr>
<td>Serial</td>
<td>#</td>
<td>Indicates the serial number of the Ultritouch panel</td>
</tr>
<tr>
<td>DashBoard Version</td>
<td>#</td>
<td>Indicates the DashBoard client version running on the Ultritouch panel</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>#</td>
<td>Indicates the build version of the Ultritouch panel</td>
</tr>
<tr>
<td>Download Logs</td>
<td>*.txt</td>
<td>Enables you to capture the communication activity of the panel into a text file</td>
</tr>
<tr>
<td>Upload</td>
<td></td>
<td>Enables you to update the DashBoard software running on your Ultritouch</td>
</tr>
</tbody>
</table>

Manage Open Views

The Open Views interface display a list of custom panels and/or device files that were previously loaded to the Ultritouch panel. To access this interface, tap Manage Open Views.
Table 10.2 summarizes the fields displayed in the Manage Open Views window.

**Table 10.2 Manage Open Views**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices</td>
<td>Tap this button to display a hierarchical list of external devices that have established communications with this Ultritouch</td>
</tr>
<tr>
<td>Files</td>
<td>Tap this icon to display a list of files recently accessed by Ultritouch</td>
</tr>
<tr>
<td>Show Navigation</td>
<td>Tap this button to display the navigation tree for</td>
</tr>
<tr>
<td>Open Selected</td>
<td>Tap this button to load the interface for the selected device</td>
</tr>
</tbody>
</table>

**Manage Custom Panels**

Use the Manage Custom Panels interface to load a custom panel file to the Ultritouch panel.

⚠️ You cannot edit a custom panel using this interface. Use the PanelBuilder™ feature in a DashBoard client to create and edit custom panels for the Ultritouch. Refer to the *DashBoard User Guide* for details.

**Connected Devices**

The Connected Devices interface provides information on the external devices currently communicating with the Ultritouch panel. From this interface you can manage which devices the Ultritouch can access.

Table 10.3 summarizes the fields displayed in the Connected Devices window.
Network Settings

The Network Settings window enables you to edit and verify the IP Address and other settings according to your facility network requirements.

Table 10.3 Connected Devices

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Reports the name assigned to the external device</td>
</tr>
<tr>
<td>Status</td>
<td>Duplicates the status reported by the device. Refer to the user guide for the device to learn more about the possible messages.</td>
</tr>
<tr>
<td>Add</td>
<td>Use this button to manually add a new device to the list of Connected Devices</td>
</tr>
<tr>
<td>Remove</td>
<td>Use this button to manually remove a device from the list of Connected Devices</td>
</tr>
<tr>
<td>Enable Auto Detect</td>
<td>Enables Ultritouch to auto-detect any DashBoard Connect compatible devices on the same IP subnet and add the device to the Connected Devices table</td>
</tr>
<tr>
<td>Enable Auto Connect</td>
<td>Enables Ultritouch to automatically connect to DashBoard Connect compatible devices and add them to the Connected Devices table</td>
</tr>
<tr>
<td>Connect</td>
<td>Enables communication between the selected device and Ultritouch</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disables communication between the selected device and Ultritouch</td>
</tr>
</tbody>
</table>

Table 10.4 Network Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP</td>
<td>###.###.###.###</td>
<td>Specifies the IP address for the Ultricore panel</td>
</tr>
<tr>
<td>Mask</td>
<td>###.###.###.###</td>
<td>Specifies the subnet mask for the Ultricore panel</td>
</tr>
<tr>
<td>Gateway</td>
<td>###.###.###.###</td>
<td>Specifies the gateway for communication outside of the local area network (LAN)</td>
</tr>
<tr>
<td>DNS (Primary)</td>
<td>###.###.###.###</td>
<td>Specifies the Primary Domain Name Server for your network</td>
</tr>
<tr>
<td>DNS (Secondary)</td>
<td>###.###.###.###</td>
<td>Specifies the Secondary Domain Name Server for your network</td>
</tr>
</tbody>
</table>
Device Options

The Device Options window enables you to adjust the display brightness and speaker volume, calibrate the hard panel settings back to their default settings, and initiate a reboot of the panel.

Manage Licenses

Use the options in the Licenses Management window to manage the licensed features for your Ultritouch. From here you can view which licensed features are enabled, and enter license keys for new features. Refer to the chapter “Installing License Keys” on page 31 for details.

Table 10.4 summarizes the fields displayed in the License Management window.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Status</td>
<td></td>
<td>Reports whether a license key is installed correctly for a licensed feature</td>
</tr>
<tr>
<td>Feature ID</td>
<td>&lt;text&gt;</td>
<td>Provides a short description of the licensed feature</td>
</tr>
<tr>
<td>Feature Name</td>
<td></td>
<td>Displays the marketing code of the licensed feature</td>
</tr>
<tr>
<td>Request Code</td>
<td>#</td>
<td>Displays the character string for the feature you wish to license</td>
</tr>
<tr>
<td>License Key</td>
<td>#</td>
<td>Displays the key code that was provided for the feature</td>
</tr>
<tr>
<td></td>
<td>&lt;blank&gt;</td>
<td>The specified license is not installed</td>
</tr>
<tr>
<td>Count</td>
<td>#</td>
<td>Specifies the number of licenses available for this feature</td>
</tr>
<tr>
<td>Install Key</td>
<td></td>
<td>Tap to apply the license key</td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td>Discards the changes made for the license key entry</td>
</tr>
<tr>
<td>Refresh</td>
<td></td>
<td>Updates the information displayed in the License Management window</td>
</tr>
</tbody>
</table>

All Connections

The All Connections interface provides access to the menu system and operational features of DashBoard Connect compatible devices. Only devices added via the Connected Devices interface, with established connections to Ultritouch, are accessible in this interface.

Tap 🗼 on the hard panel to display the All Connections interface. (Figure 10.6)
For More Information on...

- the menu system for your DashBoard Connect compatible device, refer to its user guide.

File Navigator Interface

The File Navigator interface in Ultritouch enables you to quickly navigate to any installed Custom Panel file. Custom Panels are created using the PanelBuilder tool in the DashBoard client software.

Tap on the hard panel to display the File Navigator interface. (Figure 10.7)

Open Windows Interface

The Open Windows interface in Ultritouch reports which device interfaces were recently accessed by the Ultritouch. Each device is represented by a pane in the interface which includes a thumbnail of the last menu/tab that was accessed and a status bar. Select a pane to display that device on the Ultritouch, or scroll through the panes to quickly monitor the devices communicating with Ultritouch.

Tap on the hard panel to display the Open Windows interface. (Figure 10.8)

Lock the Ultritouch Interface

You can choose to lock the hard panel so that all menus and parameters cannot be accessed.

Tap on the hard panel to lock the panel. (Figure 10.9)
Technical Specifications

This chapter provides technical information for Ultritouch. Note that specifications are subject to change without notice.

Physical Dimensions

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ultritouch-2</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>19” (48cm)</td>
</tr>
<tr>
<td>Depth</td>
<td>2.5” (6cm)</td>
</tr>
<tr>
<td>Height</td>
<td>3.5” (9cm)</td>
</tr>
<tr>
<td>Weight (approx.)</td>
<td>5.25lb (2.40kg)</td>
</tr>
</tbody>
</table>

| Ultritouch-4 |               |
| Width       | 19” (48cm)   |
| Depth       | 2.6” (6.5cm) |
| Height      | 7.0” (18cm)  |
| Weight (approx.) | 12.0lb (5.40kg) |

Ethernet Port Connectors

Each Ultritouch comes standard with two Ethernet ports on the rear panel to interface with a local network, and Ross devices that use an Ethernet protocol for communications. The Ethernet ports are operated in a link aggregated or bonded configuration to provide failover functionality.

* The ENET 2 port is not implemented.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Ports</td>
<td>1</td>
</tr>
<tr>
<td>Connector Type</td>
<td>8-pin, RJ45</td>
</tr>
</tbody>
</table>

Environmental

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Ambient Temperature Range</td>
<td>0°C to 40°C (32°F to 104°F)</td>
</tr>
<tr>
<td>Humidity, non-condensing</td>
<td>&lt; 95%</td>
</tr>
</tbody>
</table>
## Power

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ultritouch-2</strong></td>
<td></td>
</tr>
<tr>
<td>Number of Ports</td>
<td>2</td>
</tr>
<tr>
<td>Power</td>
<td>15VDC @ 4A</td>
</tr>
<tr>
<td>Input</td>
<td>100-240Vac, 50/60Hz</td>
</tr>
<tr>
<td>Input Current</td>
<td>1.4A</td>
</tr>
<tr>
<td><strong>Ultritouch-4</strong></td>
<td></td>
</tr>
<tr>
<td>Number of Ports</td>
<td>2</td>
</tr>
<tr>
<td>Power</td>
<td>15VDC @ 4A</td>
</tr>
<tr>
<td>Input</td>
<td>100-240Vac, 50/60Hz</td>
</tr>
<tr>
<td>Input Current</td>
<td>1.4A</td>
</tr>
</tbody>
</table>
Glossary

The following terms are used throughout this guide:

**Breakaway** — an act of performing a switch on only some of the signals grouped together under one label.

**Connection Point** — setting to define a communication connection between Ultritouch and a device in the routing system.

**Crosspoint** — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires one crosspoint.

**Destination** — a signal output from the routing system.

**Hard Panel** — the physical Ultritouch panel that provides a touchscreen interface to the menu system.

**IP Address** — a setting that defines the Internet protocol address of a device within a network.

**Label** — text that is used by control displays to identify a signal as an input or output.

**Level** — refers to a section of a routing system. For example, a video router would be one level and an audio router would be a second level.

**Logical (virtual) Label** — a name for a group of routing system inputs or outputs.

**Logical (virtual) Routing** — the action of switching a group of otherwise unrelated signals via a common label (name).

**Remote Control Panel (RCP)** — a physical hardware panel of buttons that is used to control the routing system.

**Salvo** — a system wide sequence of matrix control operations and crosspoint actions.

**Soft Panel** — a DashBoard software interface that represents a panel of buttons that is used to control the routing system.

**Source** — a signal input to the routing system.

**Ultritouch** — refers to both the Ultritouch-2 and Ultritouch-4 unless otherwise noted.

**Virtual Label** — a name for a group of routing system inputs or outputs.

**Virtual Routing** — the action of switching a group of otherwise unrelated signals via a common label (name).